
Getting Started
Guide

Psychology
Software
Tools, Inc.

© 2001, All Rights Reserved



    E-Prime Getting Started Guide
   Installation and Information

Installation
Note: If you are installing E-Prime and already have a previous version of E-Prime on your system, it is best to “uninstall” the older
version rather than write over it. To uninstall a previous version:

1.) From the Windows Start menu, select Settings, and Control Panel.
2.) In the Control Panel dialog, double-click on Add/Remove Programs.
3.) From the list of installed programs, select E-Prime and click Add/Remove.
4.) Select Remove from the following options, and click Next.
5.) Click OK to remove all components. Then click Finish.
6.) Reboot your computer before proceeding with the installation.

In Windows Explorer, make a backup copy of any experiments or data you would like to save from previous releases.  Then delete
the E-Prime folder from the C:\ProgramFiles\PST directory.

To install E-Prime:

1. Connect the hardware key.
You must connect the hardware key to your parallel or USB port before attempting to install E-Prime. The hardware
key is required to be in place for all single and multi-pack licenses when installing AND when working in the E-Studio
application.  Site licenses are required to have the hardware key in place during installation only.

2.  Insert the CD into your CD-ROM drive.

3.  The Setup program prompts you through the installation process.  Click Next to begin installing.

4.  Please read the License Agreement in full, and click Yes to accept terms of use.

5.  Enter or verify your User Name and University/Company Name in the Customer Information dialog. Then enter your valid
     E-Prime serial number and click Next.

Note: You may locate your serial number in the About box in the Help menu in E-Studio, on the sleeve
which holds the CD, or on the cover of the Getting Started Guide.

6.  By default, E-Prime will install to the folder C:\Program Files\PST\E-Prime. Click Next to accept.
You are given the following options for installation: Typical, Custom or Subject Station. If you choose
Typical or Subject Station, E-Prime automatically performs the installation. If you choose Custom, you will
need to select desired options. Refer to Chapter 1 - Introduction in the E-Prime User’s Guide for a
description of installation options.

7. Click Finish to end the installation. Be sure to re-boot your computer when you have finished the installation
    to make sure that all components are properly installed.

*You should not experience any problems installing E-Prime if your hardware key is properly connected, and you correctly enter
  your serial number.  However, if the installation should fail, contact PST immediately at www.pstnet.com

E-Prime Resources
Where to find information.

Currently, over 500 pages of documentation are available in various forms.  We recommend that you work through the Getting
Started Guide in its entirety.  This provides the foundation for learning to use the suite of applications which comprise E-Prime.  Only
after completing the Getting Started guides should you investigate the additional resources currently available.

Getting Started Guide

Work through the Getting Started Guide (GSG), which includes step-by-step tutorials to walk you through the basics of E-Prime.
q Tutorial 1 - E-Studio (estimated time to complete: 40-60 minutes).
q Tutorial 2 - Paradigm Wizard (estimated time to complete: 25 minutes).
q Tutorial 3 - E-Merge (estimated time to complete: 15 minutes).
q Tutorial 4 - E-DataAid (estimated time to complete: 15 minutes).

E-Prime Introduction Slideshow

The E-PrimeIntro Slideshow may be found at www.pstnet.com/e-prime/intro
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Sample Experiments

Open, Inspect and Run each program from the Samples folde (default installation C:\My Experiments\Samples)
q Text Basic Reaction Time Experiment
q Picture Reaction Time Experiment
q Slide Reaction Time Experiment
q Sound Reaction Time Experiment
q Nested Lists Experiment allows selection of different word lists from different conditions
q Nested Lists Extended Input Experiment using extended responses, borders, colors and inputs from multiple devices

It is recommended that you inspect, run and modify at least one of the sample experiments. Consider making a simple modification to
the program.

Working With E-Prime
Create your First Experiment

Although you may use one of the sample experiments as a foundation from which to build your first experiment, we recommend
starting from scratch, using either the Paradigm Wizard or the drag-and-drop method in E-Studio.  Since this is your first novel E-Prime
experiment, it is important to keep it simple (e.g., only 2 conditions, four stimuli).  Once you have the simple version of the experiment
running properly, you can add to it and make it more complex (estimated time to complete: 20-90 minutes for simple experiments).For
additional assistance, it is recommended that you read Using E-Studio, chapter 2  in the E-Prime User’s Guide:

Reporting Problems

While E-Prime is a very stable system, your feedback will greatly aid us in refining the E-Prime system.  When reporting problems, it is
essential that you minimally report the following information:

User information
Name, institution, and serial number (see below), phone number and e-mail, in case we need to contact you for more information.

Machine information
Windows version, manufacturer and model of your PC, type of CPU, amount of memory. This information can be found in the System
properties from the Windows Control Panel. From the Start menu, select Settings, and Control Panel. Double-click on System.

Information about the problem
The name of the application in which the problem occurred (E-Studio, E-Run, etc.), version number of the application (found by
displaying the About box via the About command under the application’s Help menu), any information that is displayed in the error
message you receive.  If applicable, send a copy of your .es file as an attachment.

Useful Information

How to abort an experiment early:
Press Ctrl+Alt+Shift to terminate the E-Run program.  Click OK in the dialog box verifying whether the experiment should be termi-
nated.  Click OK in the dialog box displaying the “Experiment Terminated by User” message.

Your Serial Number:
Your serial number is provided on labels included with your system. Place the labels in appropriate places so that they are acces-
sible.  Additionally, your serial number can be found in the About E-Studio dialog box located via the Help menu. DO NOT LOSE THIS
INFORMATION. You MUST provide your serial number for technical support.

User’s Guide and Reference Guide

The User’s Guide and Reference Guide are shipped with your E-Prime license.  It is extremely useful to have the manuals as a
reference point as you work through the system.  Each volume contains valuable information that will help you master the applica-
tions within E-Prime.

Resource Description Format Location

Getting Started
(this booklet)

Quick reference point for general information,
step-by-step tutorials for each application within
E-Prime

Printed Included with E-Prime shipment, AND part of  E-Prime
installation (accesed via the E-Prime menu).

User's Guide Provides technical details about each
application.

Printed Included with E-Prime shipment.

Reference Guide Fully documents features of each application. Printed Included with E-Prime shipment.

E-Basic Help Fully documents all features of each application. Online Located in the E-Prime menu off the Start Menu OR in
the Help menu within the E-Studio application.

Application Help Help for individual applications. Online Accessed through the Help menu within the application.
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Welcome to the
experiment!

PRIME + TARGET

Thank you
and Goodbye!

       Set up and run the trials.

E-Studio:
Getting Started
This guide serves as a tutorial to build your first E-Prime experiment.  The purpose of this exercise
is to familiarize you with only some of the features of E-Studio.  The actual release of E-Prime will
include a complete user reference guide and online help in addition to the Getting Started Guide.
Furthermore, there will be additional tutorials available which extend this experiment and explore
additional features of E-Studio.

The experiment used in the E-Prime Getting Started Guide is a variation of the Blair & Banaji (1996)
study examining automatic and controlled processes in stereotype priming.  With their results, Blair
and Banaji supported the proposal that stereotypes may be automatically activated, but that these
effects may be controlled, or even eliminated, by perceivers.

In the experiment described in the following tutorial, subjects will be presented with a prime word for
a short duration.  The prime word will be either stereotypically masculine or feminine (e.g., sports or
flowers) and will have either a positive or negative connotation (e.g., sports or bald).  The prime will
be replaced by a fixation (+), and then a target word will be presented.  The target word will be either
a male or female name (e.g., Bob or Linda).  The task is to respond to the target word by pressing ‘1’
if the target word is a male name or by pressing ‘2’ if the target word is a female name.  Reaction
time and accuracy will be measured.

Page 1
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The following is an outline of steps you should take to build your first experiment.  It is
highly recommended that you proceed through the entire Getting Started Guide in order to
learn E-Studio.  The purpose of the information on this page is to familiarize you with some
terms and schemes used throughout this tutorial.

You are also strongly encouraged to use the figures throughout this document as visual
guides.  In the figures, you will see various lines and arrows to point out specific areas of
interest.  Use the table below to interpret the arrows, lines, and terminology.

Click or double click on this object.

Drag the object.

Double click
Press the left mouse button twice in quick
succession.

Right click Press and release the right mouse button.

Drag

Press the left mouse button and hold it as you
move the mouse to drag the object to a new
location on the screen; then  rrelease the left
mouse button.

Drop
After a drag action as described above,
release the left mouse button to place the
object in its new location.

Resize window

To resize a window, position the mouse over
the edge until the cursor changed to a double-
pointed arrow; then drag the window to the
desired size.  As an alternative, you can use
the Window menu (in E-Studio) for quick
standardized arrangments.

Select/Highlight
Click on the object once or unti l i t is
highlighted (i .e., reverse image).

Tab Press the 'Tab' key on the keyboard.

The button on the left containing the line will
minimize a window.  The middle button
containing the box will  maximize a window.
The right button containing the X will  close the
window.

Page 2
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Task 1:  Start the E-Studio application and name
the experiment

The goal of this task is to open the E-Studio application and begin creating a new experi-
ment.

1) Click on the Start Menu,
select Programs, and
then select E-Prime.
From the E-Prime menu,
click on the E-Studio
application.

This will launch the E-
Studio application.

2) Select the Blank Ex-
periment option and
click OK.

A dialog box is
presented each time E-
Studio is launched.
You can create a new
experiment with E-
Studio (Blank
Experiment) or with the
Paradigm Wizard.
Another  option is  to
open an existing
experiment.
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Task 2:  Preview the E-Studio interface

This task will introduce you to the major components and features of the E-Studio interface.
Note that you may resize the various windows to reveal more of the Workspace.

1) Locate the Toolbox,
which contains objects
that are dragged to
procedural timelines.
The objects are the
basic building blocks of
your E-Studio experi-
ments.

You can remove the
captions on the objects
by right clicking in the
Toolbox and removing
the check next to the
Captions option.

2) Locate the Structure
view, which contains a
hierarchical representa-
tion of your experiment.

This window features a
tree view similar to that
in Windows Explorer.

3) Locate the Properties
window, which contains
the list of associated
properties for each
object.

Each object has a set
of associated
properties displayed in
the Properties window
when the object is
highlighted.

4) Locate the
Workspace, which
contains the window
representations of the
various objects.

You can open a
window representation
of an object by double
clicking on it in the
Structure view.

Page 4



    E-Prime:  Getting Started Guide
    Application:  E-Studio

uw

Task 3:  Create your first object

The next few steps will create a new text display object.  All of the properties related to this
object will be explained in detail.  Later, you will be expected to recall the steps necessary
to set object properties.

1) Double click the
SessionProc object in
the Structure window.

This will open a
window version of the
object in the
Workspace.  The
Procedure objects
feature a timeline.
This SessionProc
object was created for
you by E-Studio.  As
you work through this
tutorial,  you can
resize the various
windows to fit in the
Workspace.

2) Drag the TextDisplay
object from the Toolbox
to the beginning of the
SessionProc timeline.

This is also reflected in
the Structure window.
Notice changes in the
experiment
representation in the
Structure window as
this tutorial continues.

3) Highlight the newly
placed TextDisplay
object (by clicking on
it) to view its properties
in the Properties win-
dow.

Highlight the object in
either the Structure
view or on the
SessionProc.  Every
object has a set of
associated properties
which are displayed in
the Properties window
when the object has
the focus selected.

v

Page 5



    E-Prime:  Getting Started Guide
    Application:  E-Studio

Task 4:  Name the TextDisplay object

In this step, you will learn how to name the objects in your experiment by using the
Properties window.

1) In the Properties win-
dow, locate the (Name)
property.

This feature is similar
to that in Visual Basic.
The highlighted
object’s associated
properties are listed in
alphabetical order.
However, the most
frequently used
properties are located
at the top of the list.

2) Click in the box to the
right of (Name) and
change the value from
TextDisplay1 to In-
structions (and press
the Enter key).

Notice that the object’s
name has changed in
both the Structure
window and in the
SessionProc timeline.
These displays are
updated when you
press Enter.
Remember: youmay
resize the windows
in the Workspace.

u v
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Task 5:  Save the experiment and open the Instructions
object

The goals of this task are to save the experiment and then continue by opening the window
representation of the TextDisplay object named “Instructions.”

1) From the File menu,
select the Save As...
command (or press
F12).  In the My Experi-
ments folder, name the
file Tutorial.  Click the
Save button to dismiss
the dialog.

2) Double click the
object named Instruc-
tions either in the
Structure window or the
SessionProc timeline.

This will open a
window version of the
TextDisplay object
named Instructions.

3) Click on the Proper-
ties button in the upper
left corner of the
TextDisplay window.

This will open a set of
tabbed pages called
Property Pages, which
will allow you to
specify the object’s
properties.

Page 7
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Task 6:  Specify the Instructions object properties

The goal of this task is to specify the properties for the TextDisplay object named “Instruc-
tions.”  This object’s purpose is to display a set of instructions in black text on a white
background.  The display should remain on the screen until a response is collected.

1) On the General tab of
the Properties dialog,
locate the Text field
and type:  “Welcome
to the experiment.
<Enter> You will see a
priming word fol-
lowed by a fixation.
<Enter> A target word
will follow the fixa-
tion. <Enter><Enter>
Your task is to deter-
mine if the target
word was a male or
female name.
<Enter><Enter> Press
the “1” key for a male
name and the “2” key
for a female name.
<Enter><Enter>
PRESS THE
SPACEBAR TO
BEGIN!”

This will be the text
displayed to the
subject.

2) Click on the Duration/
Input tab.  Specify the
Duration of the display
to be 10000.

The duration is in
milliseconds by default.

Page 8
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Task 7:  Enable input from the keyboard

The goal of this task is to enable input via the keyboard and complete the properties for the
Instructions object.

1) Still on the Duration/
Input  page, click the
Add button under the
Device(s) window.

The Add Input Device
dialog will be
displayed.

2) Click the Keyboard
device to select it, and
click OK.

The keyboard will now
be enabled as an input
device, and the
Response Options
fields will become
available.

3) Specify the Allowable
response to be the
spacebar.

To specify a spacebar
press in the Allowable
response field, enclose
the word “SPACE”
in curly brackets ({ })  .
Curly brackets tell E-
Prime that the word
“SPACE” refers to a
special character.

4) Set the display to
terminate when a
response is collected
(select Terminate in
the EndAction field).
When you are finished,
click OK to exit the
Property Pages.

5) Close the Instructions
object.

v

u
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Task 8:  Create the Goodbye object

The goal of this task is to create and specify the properties for the TextDisplay object that
will dismiss the subject at the end of the experiment.  The subject should see a dismissal
text, and it should appear for 5 seconds before the experiment terminates.

1) Drag a TextDisplay object
from the Toolbox to the
SessionProc and rename it
“Goodbye.”

The new TextDisplay object
should be placed at the end
of the SessionProc timeline.
Rename the object as before
by highlighting it and
changing the (Name)
property in the Properties
window.  A fast way to
rename is to click on the
object in the Structure
window, press F2, and type
in the new name.

2) Double click the Goodbye
object to open its window in
the Workspace.  Then open
its Property Pages.

3) On the General tab, locate
the Text field and type,
“Thank you and Goodbye.”

This will be the text displayed
to the subject.

4)  Specify the Duration of the
display to be 5000. Do not
add an input Device.

No responses will be reg-
istered by the Goodbye
object. The display  will
terminate when the
specified duration has expired.

5) Close the Goodbye object in
the Workspace.

w

x
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Task 9:  Create the BlockList object

The goal of this task is to create the BlockList object.  It is helpful to think of your experi-
ment in a hierarchical manner.  For instance, the SessionProc object is the foundation for
the entire experiment.  This procedure contains all high-level events, such as a welcoming
screen of instructions, a goodbye screen at the end of the experiment.  Between these two
are the blocks of trials.  This tutorial experiment will contain one block of trials.

1) Drag the List object in
the Toolbox to the
middle of the
SessionProc timeline
and change its name to
BlockList.

Change the name by
highlighting the List
object and locating the
(Name) property in the
Properties window.
This particular List
object is in place for
future adaptations of
this experiment (e.g.,
adding multiple
blocks).

v
2) Double click the

BlockList object.
This will open the
BlockList object’s
window in the
Workspace.
Remember to resize
the windows in the
Workspace to
maximize your view.

3.) Now is a good time to
save your experiment! To
do this, press Ctrl-S,
select Save in the File
menu, or click the Save
icon on the Toolbar.)

u

w
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Task 10:  Define the BlockList object

Now that the BlockList object has been created, it must be defined.  The goal of this task is
to specify the various attributes needed for the tutorial experiment.

1) Click the Add At-
tribute tool button in
the BlockList object.

This will open a dialog
box, which allows
specific properties of
the List object to be
set.

2) Type “PracticeMode”
in the Name field and
click Add.

This will create a new
attribute called
PracticeMode.  In a
future tutorial, we will
expand this experiment
to include blocks of
both practice and real
trials.

Note:  Spaces are not
permitted in attribute
names

3) Type “no” in the first
cell of the column
labeled PracticeMode.

This will specify that
the value of the
attribute PracticeMode
is equal to “no.”

Page 12
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Task 11:  Create and define the BlockProc object

The goal of this task is to create a new Procedure object called BlockProc.

1) Type “BlockProc” in
the first cell of the
Procedure column and
press Enter.

This specifies that the
information contained
within this row is to be
applied to the
procedure called
BlockProc.

2) A dialog is displayed
indicating that the
BlockProc procedure
does not exist.  Click
Yes to create the Pro-
cedure object
BlockProc.

Notice the BlockProc
procedure has been
created in the
Structure window.

3) Close the SessionProc
and BlockList windows
in the Workspace.

4) Save your experiment!
Press Ctrl-S or click
Save in the File menu.

5) Click the Generate
button to compile the
experiment script as
specified thus far.

It is a good practice to
generate your script
after the completion of
individual parts of an
experiment in order to
catch potential errors.

v

y
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Task 12:  Create and define the TrialList object
The goal of this task is to learn how to specify the attributes of your trials.  Essentially, the
List object is where you specify all of the variables, factors, and their attributes.  It will be
necessary to resize this window in your W orkspace.  Hint: MEL Professional users can
think of this as an Insert Form.

1) Double click the BlockProc
object in the Structure window.

2) Drag a new List object to the
BlockProc timeline and re-
name it TrialList.

3) Double click the object
named TrialList on the
BlockProc timeline.

This will open the TrialList
spreadsheet-like window in the
Workspace.  Resize the
window as needed.

4) Click the Add Attribute tool
button on the top of the
TrialList window.

This will open the Add Attribute
dialog box.  Think of attributes
as columns of a spreadsheet.

5) Specify the Name of the
attribute to be PrimeGender
and the Default Value to be
female.  Click Add when you
are finished.

The name of your first attribute
is PrimeGender.  The priming
word displayed will be
stereotypically male or female.
Thus, this column will
eventually be filled with values
of either ‘male’ or ‘female’ (the
levels of this attribute).  The
Default Value is useful in
saving typing time.  By
specifying ‘female’ as the
Default Value, all of the cells in
the PrimeGender column will
have the value of ‘female.’

Page 14



    E-Prime:  Getting Started Guide
    Application:  E-Studio

v

v

Task 13:  The TrialList object continued...

The goal of this task is to specify all of the attributes for your trials.

1) Add the following
attributes by using the
Add Multiple At-
tributes tool button. In
the Add Multiple At-
tributes dialog, type 5
and Click OK.

2.) Double-click on the
column headings for
Attributes 1-5 to change
names and specify default
values.

When you are finished,
your TrialList object
should look similar to
the one shown to the
right.  Note that you
can hide the Summary
information by
clicking the Hide
Summary tool button.
ToolTips are available
for each of the tool
buttons and  can be
accessed by resting
the cursor on top of
the button for a few
seconds.

    Default
     Name     Value
PrimeType     positive
NameGender     female
CorrectAnswer     1
Prime     ?
Target                 Linda

u
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Task 14:  The TrialList object continued...

The goal of this task is to specify all of the levels for each attribute.  Think of the levels as
rows in the spreadsheet.

1) Click the Add Multiple
Levels tool button and
enter 7 to add 7 levels.

The Default Values
specified earlier are
automatically filled in for
you (except for the first
row).

2) Using the table below,
complete the TrialList
object grid to match the one
shown to the right.

The Nested column is not
used in this experiment,
and will be left blank.
When completing the
Procedure column, a
dialog will be displayed indi-
cating that the TrialProc
has not been created.
Click Yes to create it.

Name          Values
Procedure        TrialProc

PrimeGender        male,
       female

PrimeType              positive,
                   negative

NameGender          male,
       female

CorrectAnswer        1, 2

Prime                      sports,
                               bald,

       flowers,
                   laundry

Target                     Bob, Linda

3)  Save and generate the
experiment.
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Task 15:  Specify the TrialList object properties and cre-
ate the Trial procedure

Like all objects in E-Studio, the List object has properties.  The List object features a variety
of properties related to condition selection (how the rows of information are ordered and
selected), and these properties are located in a set of Property Pages.  This task will guide
you through the specification of those properties.

1) Click the Properties button in
the TrialList window.

A set of tabbed Property
Pages is opened.  Here, you
will specify the condition
selection options.

2) Click on the Selection tab
and set the Order of selec-
tion to Random from the
drop-down box.

The Random ordering option
is random without
replacement.

3) Select the Reset/Exit Tab
and verify that the option to
reset after “All samples (8)”
is selected.

Only after all samples  have
 been selected/used, will
they be eligible for use
again, if necessary.

4) Review the Summary and
close the window by clicking
OK.

Notice that the summary is
reflected on the List object,
and may be shown or
hidden using the Summary
toggle button.

5) Close all open windows in
the Workspace and save
the experiment!

6) Click the Generate button
to generate the script ac-
cording to the settings so
far.
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Task 16:  Define the TrialProc

The next few steps will define the procedure named TrialProc.  Essentially, you will be
defining what constitutes a single trial.  In this experiment, a single trial consists of four
events, including the presentation of: the Prime, a Fixation display, the Target (where a
response is collected from the subject), and Feedback based on the subject’s response.
Thus, the TrialProc procedure should have 4 objects on its timeline.  These objects will be
created and defined in the next few steps.

1) Double click the TrialProc
object in the Structure win-
dow.

2) Drag a TextDisplay object
from the Toolbox and drop it
on the timeline.  Rename
this object Prime.

3) Use the Properties window
to specify Duration to be
1000 milliseconds and the
Alignment to be in the
center of the screen (de-
fault).

4) From the View menu, select
Attributes.

The Attributes window will
appear on the right side of
the Workspace.  It lists all of
the attributes declared in the
List objects created thus far.

5) Drag the Prime attribute
from the Attributes window
to the Text property field in
the Properties window.

Notice the attribute Prime is
inserted (enclosed in square
brackets) as the value of the
Text property.  The prime
display is something that will
vary with each trial.  This
notation means that each
trial will insert the current
value of the attribute named
Prime in the text display.

6) Close the Attributes win-
dow.

z
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Task 17:  Define the TrialProc, continued...

This step will create and define the second object on the TrialProc timeline: the presenta-
tion of a fixation.

1) Drag a TextDisplay
object from the Toolbox
and drop it on the
timeline.  Rename this
object Fixation.

You can also rename
objects from a context
menu within the
Structure window or on
the procedure in the
workspace.  Access the
Context Menu by right
clicking on the object
you wish to rename and
selecting the
Rename command.

2) Try using the Property
Pages instead of the
Properties window.
(Either of these meth-
ods can be used effec-
tively to specify proper-
ties.)  Double click the
Fixation object to open
it in the Workspace, and
click the Properties
button.

3) Specify the Text to be a
+, the Duration to be
1000 milliseconds, and
the AlignVertical and
AlignHorizontal proper-
ties to be set to center
(default).

Duration is set via the
Duration/Input tab. The
Fixation window should
then look as it does
below right.

4) Click OK, close the
Fixation window, and
save the experiment.

w
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Task 18:  Define the TrialProc, continued...

This step will create and define the third object on the TrialProc timeline: the Target stimu-
lus display.

1) Drag a TextDisplay
object from the Toolbox
and drop it at the end
of the TrialProc
timeline.  Rename this
object Target.

2) In the Properties win-
dow, set the Text field
to refer to the Target
attribute.

To do this, you will
have to open the
Attributes window
from the View menu
again.  Then drag the
attribute Target to the
Text field in the
Properties window.
This allows the text
displayed for this
object to vary based on
the current trial
information.  Notice
that variable
information is
displayed in blue type
after exiting the cell.

3) Close the Attributes
window.
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Task 19:  Enable Input

The goal of this step is to set the properties for subject input.

1) In the Properties win-
dow for the Target
object, click in the
Duration field and then
on the ellipsis that
appears in the field.

This is another way to
display the Property
Pages for the Target
object.

2) On the Duration/Input
tab, set the Duration to
10000.

3) Add the Keyboard as
the input Device,
specify the Allowable
responses to be the “1”
and “2” keys, and set the
EndAction to Termi-
nate upon response.

4) Set the Correct re-
sponse field to refer to
the [CorrectAnswer]
attribute and click OK.

5) A dialog will be dis-
played indicating that
data logging is not yet
enabled.  Click Yes to
set the data logging to
Standard.

6) Click OK to accept the
settings and dismiss
the Properties window.

u
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Task 20:  Define the TrialProc, continued...

This step will create and define the fourth and final object, the Feedback object, on the
TrialProc timeline, and will link the Feedback object with the input object (Target).

1) Drag the
FeedbackDisplay object
from the Toolbox and
drop it at the end of the
timeline.  Rename this
object Feedback.

2) In the Properties win-
dow, specify the
InputObjectName to
be Target.

This should not be
confused with the
attribute named Target.
This field is asking for
the name of the object
where the subject
response is being
collected.  In this
experiment, the
subject’s response is
collected in the
TextDisplay object
named Target.
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Task 21:  Specify the properties for the Feedback object

The goal of this task is to specify the properties for the various types of feedback pre-
sented.

1) Double click the
Feedback object in the
TrialProc to open it in
the Workspace.

2) Click on the text box
containing the “Cor-
rect!” message to
select the sub-object,
and click the Proper-
ties  button to display
the Property Pages for
the sub-object.

3) On the General tab,
set the Text field to
read “Good job!” and
the AlignHorizontal
field to “center.”

4) Click the Frame tab
and set the
BorderWidth to “10” to
create a thick border
around this text.

5) When finished, click
OK to dismiss the
Property Pages, and
click on the Feedback
object outside of the
text box area to dese-
lect the sub-object.

v
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6) Close the Feedback

and TrialProc windows.
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Task 22:  Generate the Script!

You have completed an experiment using E-Studio!  Now that your experiment is com-
pleted, you only need to generate the script.

1) First, save the experi-
ment as it exists now.

Press Ctrl-S or select
Save in the File menu.

2) From the View menu,
select the Script and
Output windows.

When a window is
currently in view on the
desktop, there is a
checkmark next to it in
the View menu.

3) Notice the Output win-
dow in the lower left
corner of the interface.
When you generate the
script, E-Studio provides
feedback of the progress
in the Output window.
Click the Generate
button to generate the
script in the Script win-
dow.

The Generate command
writes a script file (as
can be seen in the
Script window), which
will later be compiled by
the E-Run application.

4) You can see the script
that E-Studio generates
for you in the Script
window.  You could have
spent days or weeks
writing all that code, but
you did it with E-Studio
in about an hour or less!

w

x

Page 24



    E-Prime:  Getting Started Guide
    Application:  E-Studio

x

w

u

Task 23:  Run your experiment!

Congratulations on completing your first experiment in E-Studio!  If you specified everything
correctly, you should have a functioning experiment.

1) Review your experiment
structure.

Compare the structure of your
experiment to the diagram
included on page 1 of the
tutorial to see the
implementation of the original
experimental design in E-
Studio.

2) Click the Run tool button.
If the experiment script is
generated successfully, the E-
Run application will be
launched to execute the E-
Basic script (ebs) file.  If errors
are generated, refer to the
tutorial on troubleshooting (in
this manual) for additional
information.

3) At the beginning of each run,
several subject initialization and
startup dialogs are presented in
order to collect subject informa-
tion.  Click OK in each dialog to
accept the default settings and
begin the experiment!

4) To terminate an experiment
before its normal completion,
use the Ctrl-Shift-Alt key
combination (hold down all at
once).  This will terminate the
E-Run application.

A dialog will be displayed,
asking if you are sure you
want to terminate the run.
Click Yes, and another dialog
will indicate that the run
was terminated early.  Simply
dismiss the dialog by
clicking OK.

v
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Troubleshooting
This guide serves as a tutorial for debugging and troubleshooting your E-Prime experi-
ments.  The end of this tutorial includes a table of common error messages, their descrip-
tions, and possible solutions.
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Task 1:  Generate a compile error

The goal of this task is to generate and handle a compile error.  This task will introduce a
compile error by asking the Feedback object to provide feedback for an object that is not
collecting the required statistics.

1) Open E-Studio and load
the Tutorial.es program.

A copy of Tutorial.es is
included in the My
Experiments/Tutorials/
Data/Originals folder.
Copy this program into
the current directory.

2) Double click the Feed-
back object in the
Structure window to
open it in the
Workspace.

3) Use the drop-down
menu at the top of the
toolbar to select  the
entire object Feedback
object, rather than any of
the sub-objects.

The input object is
referenced by the
Feedback object rather
than by any of its sub-
objects.

4) Click the Properties
button to display the
Property Pages for the
Feedback object.

5) Change the Input
Object Name field from
Target to BlockList by
typing directly in the
field, and click OK.

A List object does not
have ACC or RT stats,
so this will cause an
error to be generated.

v
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Task 2:  Generate a compile error continued...

This task will run the program to generate the error, and explain how to interpret the infor-
mation displayed.

1) Click the Run button to
generate the compile
error.

When a compile error
is generated, an error
dialog is displayed, the
run terminates, and the
E-Run window remains
open on the Task Bar.

2) Examine the Compile
Error dialog.  Then click
OK to dismiss the dialog.

The error dialog
indicates the line in the
script at which the
error occurred, and
briefly describes the
cause of the error.  In
this case, ACC is not a
property of a List
object, so Feedback
cannot be provided.

u

Page 28



    E-Prime:  Getting Started Guide
   Troubleshooting

w

x

x

u

v

Task 3:  Generate a compile error continued...

The next few steps will describe alternate methods of viewing the compile error and locat-
ing the line of script that caused the error.

1) Using the View menu,
open both the Output
and Script windows.

These windows will be
used to view the error
message and locate
the appropriate line of
script.

2) In the Output window,
click the Debug tab
(default) to view the
compile error.

This is helpful for
reviewing error messages
after the error dialog is
dismissed.

3) Click in the Script win-
dow to switch the focus to
this window, and then
press Ctrl-G.

A Go To dialog will
appear.

4) Enter the line number
listed in the error mes-
sage and click the Go
To button.

The cursor will be placed
in the Script window, and
will be blinking at the line
at which the error
occurred.
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Task 3 continued...

5) Now we will correct our
error.  Click in the
Feedback window that
you opened in the
Workspace.  Make sure
that the entire Feedback
object is shown in the
window at the top of the
toolbar. Open this
object’s Property Pages
again by clicking on the
Properties icon.

6) In the Feedback Prop-
erties window, reset
the “Input Object
Name” field to Target.
Click OK.

7) Close the Feedback,
Script, and Output
windows.

8) If you like, you can
rerun the program to
ensure that the error
has been eliminated.

Page 30



    E-Prime:  Getting Started Guide
   Troubleshooting

Task 4:  Generate a Run-time error

The goal of this task is to generate and handle a Run-time error.  This task will introduce a
Run-time error by asking the Target object to display the value for an attribute that does not
exist.

1) In the Structure window,
double click the Target
object to open it.

The Target object is used
to display the values of the
[Target] attribute.

2) Edit Target to display
[Tarfet] instead of [Target].

Spelling errors are the
most common causes of
errors within E-Prime.
Always double check your
typing, especially in the
List object.

3) Click the Run button to
generate and run the
script.

4) Hit <Enter> in the subject
initialization and startup
dialogs to accept the
default values and begin
the experiment.

5) Examine the Run-time
error.  When you are
finished, click OK to
dismiss the error dialog.

The error occurred
because the attribute
[Tarfet] does not exist.

6) To eliminate the error, fix
the spelling error and rerun
or close the experiment.

u

v

w

y

z

Page 31



    E-Prime:  Getting Started Guide
   Troubleshooting

Table of Common Errors
The following table lists commonly encountered errors, a description of the error, and possible solutions to
eliminate the error. A complete listing of errors may be found in the Reference Guide Appendix A - Error List.
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Number Displayed Message Error Description Solution

10000 The allowable response
was unrecognized:
<response>

The value entered in the Allowable field in the
Response Options (Duration/Input Property Page) is
not recognized by the input mask.

Enter device specific values for
allowable response.

10001 The allowable response
cannot be empty

The Allowable field in Response Options
(Duration/Input Property Page) must contain a value
when input is enabled.

Enter device specific values for
allowable response.

10002 Cannot have duplicate
response

A single value has been entered more than once.
Since the Allowable field in the Response Options
(Duration/Input Property Page) represents a mask of
values, entering duplicate values would be redundant.

Verify that unique entries are
entered only once.

10017 Invalid Termination
Response

The value entered in the Termination Response field in
the Advanced Response Options (Duration/Input
Property Page) is not recognized by the input mask.

Enter device specific value for the
termination response.

10018 Correct Response is not
part of Allowable

The value entered in the Correct Response field in the
Response Options (Duration/Input Property Page) is
not included as part of the Allowable Response
Options.

Specify a value that is included
as part of the Allowable
Response.

10019 Termination Response is
not part of Allowable

The value entered in the Termination Response field in
the Advanced Response Options (Duration/Input
Property Page) is not included as part of the Allowable
Response Options.

Specify a value that is included
as part of the Allowable
Response.

10044 The name cannot be
longer than 80
characters!

An object was named in the interface with a length of
more than 80 characters.  An object name can only
contain A-Z, a-z, 0-9, must begin with an alphabetic
character, must not contain more than 80 characters,
and must be unique within the system.

Enter a valid name through the
Properties window, Procedure
time line, or Structure view
windows that does not have more
than 80 characters.

10046 Name contains an invalid
character.

An object was named in the interface with a value that
contains an invalid character.  E-Object names are
generated to E-Basic script, which does not permit
variable names to have invalid characters.  An object
name can only contain A-Z, a-z, 0-9.

Enter a valid name through the
Properties window, Procedure
timeline, or Structure view
window  that does not have any
invalid characters.

18005 Cannot load sound file
<file>.    <error>

An error occurred while attempting to load a sound file.
This can be due to file not found, file already open,
lack of resources, invalid configuration, or improper
driver.

Ensure that the configuration of
the file matches the configuration
of the sound device, that the file
is not already open, and that the
filename and path are valid.

18010 The value for MaxLength
is invalid

The MaxLength field of the Sound object (General
property page) represents a value that is not valid.
Valid values for MaxLength cannot be less than 100.

Set the value of MaxLength to a
value no less than 100.

18011 The value for
BitsPerSample is invalid

The BitsPerSample field of the Sound device
(Experiment Object; Devices tab) represents a value
that is not valid.  Common values are 8 and 16, but the
settings are hardware dependent.

Set the value of BitsPerSample
to 8 or 16 to match the format of
the WAV file.  All files must be
saved using the same format.

18012 The value for Channels is
invalid

The Channels field of the Sound device  (Experiment
Object; Devices tab) represents a value that is not
valid.  Valid values are 1 for mono and 2 for stereo.

Set the value of Channels to 1 or
2 to match the format of the WAV
file.  All files must be saved using
the same format.

18013 The value for
SamplesPerSecond is
invalid

The SamplePerSecond field of the Sound device
(Experiment Object; Devices tab) represents a value
that is not valid.  Common values are 11025, 22050,
44100, but settings are hardware dependent.

Set the value of
SamplesPerSecond to 11025,
22050, or 44100 to match the
format of the WAV file.  All files
must be saved using the same
format.
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Welcome to the
experiment!

PRIME + TARGET

Thank you
and Goodbye!

       Set up and run the trials.

Using the Paradigm
Wizard
The experiment used throughout the E-Prime Getting Started Guide is a variation on the Blair
& Banaji (1996) study examining automatic and controlled processes in stereotype priming.
With their results, Blair and Banaji supported the proposal that stereotypes may be automati-
cally activated, but that these effects may be controlled, or even eliminated, by perceivers.

Note:  The following tutorial assumes that you have successfully completed the E-Studio
tutorial in this manual.

In the experiment described in this tutorial, subjects will be presented with a prime word for
a short duration.  The prime word will be either stereotypically masculine or feminine (e.g.,
sports or flowers), and will have either a positive or negative connotation (e.g., sports or
bald).  The prime will be replaced by a fixation (+), and then a target word will be pre-
sented.  The target word will be either a male or female name (e.g., Bob or Linda).  The
task is to respond to the target word by pressing a “1” if the target word is a male name, or
by pressing “2” if the target word is a female name.  Reaction time and accuracy will be
measured.
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Task 1:  Launch the Paradigm Wizard

The Paradigm Wizard may be used to quickly construct the framework for an experiment
This step guides you through opening the Paradigm Wizard.

1) Launch E-Studio by
clicking the Start
button and selecting
Programs.

2) From the Programs
menu, select E-Prime.

3) From the E-Prime
menu, select E-Studio.

A dialog is displayed
allowing you to open a
blank experiment,
create an experiment
using the Paradigm
Wizard, or open an
existing experiment.

4) Click the radio button
next to Paradigm
Wizard to select it.

5) Click OK.
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Task 2:  Select the general paradigm

This step guides you through choosing the general paradigm and creating a reaction time
experiment.

1) Select the Choice
Reaction Time Wiz-
ard.

Currently, this is the
only paradigm enabled,
and it is selected by
default.

2) Click OK. u

v
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Task 3:  Specify subject instructions

This step will guide you in selecting the number of subject instruction screens to be pre-
sented.

1) For the current experi-
ment, only one screen
of instructions is neces-
sary.  Set the number
of screens to “1” (de-
fault).

2) Click Next. u

v
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Task 4:  Set the number of blocks to be run

This step shows you how to set the number of practice and experimental blocks to be run.
The automaticity in stereotyping experiments calls for one practice block and one block of
real trials.

1) Set the number of
practice blocks to “1”
(default).

2) Set the number of
experimental blocks to
“1” (default).

3) Click Next.
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Task 5:  Set Block level variables

This step will guide you through defining your block level variables.  The current experiment
includes only one block level variable, PracticeMode.

1) Click in the checkbox
next to PracticeMode
in the list of Recom-
mended Block Vari-
ables.

2) Click Next.

u
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Task 6:  Set the number of trials to be run

This step guides you through designating the number of trials to be run.

1) Using the up arrow on
the right side of the first
text box, set the num-
ber of practice trials to
“4.”

2) Using the up arrow on
the right side of the
second text box, set
the number of  trials in
experimental blocks to
“8.”

3) Click Next.
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Task 7:  Set Trial level variables

This step will guide you through setting the variables at the trial level.

1) The Automaticity in
Stereotyping experiment
includes the following trial
level variables:

PrimeGender
 PrimeType
NameGender
      Prime
     Target

2) Click the Add Variable
button 5 times to create 5
trial level variables.  The
new variables will appear
under Trial Form Vari-
ables (e.g., TrialVar1).

3) Change the default
names of these variables
to the more meaningful
names above.  To do this,
place the cursor over a
box (e.g., the one con-
taining TrialVar1), and
click to select the box.
Then type the new
variable name (e.g.,
PrimeGender) in the box.
Move to the next field by
using the up and down
arrow keys or by pressing
<Enter>.  Enter all 5
variables as shown above
in step #1 above.

4) Click the checkbox next
to CorrectAnswer in the
Recommended Trial
variables list.

This will add
CorrectAnswer as an
independent Variable.

5) Click Next.
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Task 8:  Define the trial events

This step guides you through setting the specific events that will occur within each trial.

1) Note that by default,
the trial events include
Fixation, Stimulus
Display, and Feedback.
Click the checkbox
next to Pre-Trial Orien-
tation to add this
event.

This will be used to
display the Prime.

2) Verify that the
checkbox next to Fixa-
tion is selected to
present a fixation.

Note:  If you click on a
checkbox that has
already been selected,
then you will deselect
it.

3) Verify that the
checkbox next to
Stimulus Display is
selected.

This display will be
used to present the
Target,  and to collect
a response.

4) Verify that the checkbox
next to Feedback is
selected.

This display will be
used to present
feedback based
to the subject’s
responses.

5) Click Next.

w x
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Task 9:  Set the properties for the Pre-Trial Orientation

This step will guide you through setting up the Pre-Trial Orientation display, which will
display the Prime for 1000 milliseconds.

1) Select the “your task
is” text in the Pre-Trial
Orientation window and
delete it.

2) Drag [Prime] from the
Variables list (located
to the right of the text
window) to the center
of the text window.

[Prime] should be
displayed in the center
of the display.

3) Click the Duration/
Input button to display
the Duration & Input
dialog.

4) Click the OK button to
accept the default
(which is to collect no
response and display
for 1000 ms).

5) Click Next.
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Task 10:  Set the properties for the Fixation display

This step guides you through setting the properties of the Fixation display, which will con-
sist of a “+” displayed in the center of the screen for 1000 milliseconds.

1) By default, the Fixation
display screen gener-
ated by the Wizard
consists of a “+” symbol
centered in the display.

2) Click the Duration/
Input button to bring up
the Duration & Input
dialog.

3) The default for the
fixation display is to
terminate the display
after 1000 milliseconds
without collecting a
response.  Click OK to
accept this default.

4) Click Next to continue
with the next step of the
Wizard.
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Task 11:  Set the properties for the Stimulus Display

This step will guide you in setting up the Stimulus display, which will display the Target and
collect a response.

1) Select the “<insert
stimulus here>” text in
the Stimulus Display
window and delete it.

2) Drag [Target] from the
Variables list (located
to the right of the text
window) to the center
of the text window.

You may have to scroll
down to find [Target] in
the Variables list.

3) Click the Duration/
Input button to display
the Duration & Input
dialog.

4) Verify that the radio
button to enable re-
sponse collection (i.e.,
“Yes, collect a re-
sponse using the
following...”) is se-
lected.

5) Under Duration, locate
the field that specifies
that the display remain
up until “the subject
responds or 5000 ms
has elapsed.”

Continued next page...
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Task 11 continued...

6) Change the duration to
10000 ms (i.e., high-
light the 5000 and
enter 10000).

7) Under Response
Key(s), set the allow-
able keys to “12.”  To
do this, highlight (any)
in the Allowable field,
and enter 12.

8) From the drop-down
box in the Correct field,
scroll down and se-
lect [CorrectAnswer].

9) Click OK to accept the
settings and dismiss
the Duration & Input
dialog.

10) Click Next in the
Stimulus Display win-
dow to continue.
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Task 12:  Determine the number of Subject Dismissal
screens

This step will guide you in selecting the number of dismissal screens to be presented to the
subject.

1) Set the number of
dismissal screens to be
“1” (this is the default).

2) Click Next to continue.
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Task 13:  Finish

This step guides you through completion of the Paradigm Wizard.

1) Click Finish.
The Paradigm Wizard
will generate an
experiment shell based
on the properties
designated for each of
the displays, and will
open this experiment
shell in E-Studio.

u

Page 47



    E-Prime:  Getting Started Guide
    Application:  Paradigm Wizard

Task 14:  Examine the experiment generated by the
Paradigm Wizard

This step guides you through the examination of the experiment shell created in E-Studio
by the Paradigm Wizard.

1) In E-Studio, examine
the Structure window of
the experiment gener-
ated by the Wizard.

2) Open the various
objects in the
Workspace to deter-
mine whether the
properties are set
correctly.

3) The Wizard generates
the shell of the experi-
ment, which will run as-
is.

The Wizard enters
question marks (?) as
placeholders for
undefined values.  To
complete the
experiment,  you need
to fill in the instructions,
the stimuli to be
presented, and the
goodbye text.
Follow the next few
steps to complete the
PracTrialList and the
TrialList.

4) Save your experiment
as WizardTutorial
using the Save As
command in the File
menu.

u
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Task 15:  Complete the PracTrialList

This step guides you through the completion of the PracTrialList object, which will define
the stimuli to be displayed during the practice trials.

1) In the Structure win-
dow within E-Studio,
double click
PracTrialList to open
this object in the
workspace.

2) Complete the
PracTrialList so that it
matches the one to the
right.

The PracTrialList
defines the stimuli that
will be presented
during the block of
practice trials.

Note:  The Nested
attribute is unused in
this experiment, so it
has been hidden.  To
hide Nested, click on
the column heading,
right click, and select
Hide Attribute from the
menu that appears.

3) Close the PracTrialList
window in the
Workspace.
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Task 16:  Complete the TrialList

This step guides you through the completion of the TrialList object, which defines the
stimuli to be displayed during the experimental trials.

1) In the Structure win-
dow, double click
TrialList to open this
object in the
Workspace.

2) Complete the TrialList
object so that it
matches the one to the
right.

3) Save, Generate, and
Run your experiment.

Your program will now
display the stimuli
entered in the
PracTrialList and
TrialList objects, and
will score the response
collected in relation to
the CorrectAnswer
attribute.  To edit the
text displays, simply
open the objects in the
Workspace and edit
the text.
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Merging Data Files
Task 1:  Open E-Merge

The E-Merge application may be used to merge individual data files into a master file for
analysis.  This step guides you through opening the E-Merge application.

1) From the Start
menu, select Pro-
grams, E-Prime,
and E-Merge.

A Quick Reference
dialog is displayed
to aid in the
merging of files.

2) Click Close to
dismiss the Quick
Reference dialog, or
simply reposition it
by clicking on the
title bar and drag-
ging the dialog to
the side of the
screen.

The Quick
Reference dialog
may be
redisplayed using
the View menu.
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Task 2:  Locate your experiment files

The Folder Tree window on the left side of the E-Merge display allows you to navigate to
the folder containing your data files.  This step will guide you through locating the data files
to be used in this tutorial.

1) In the Folder Tree,
navigate to the C:/
My Experiments/
Tutorials/Data
folder.

Located within the
Data folder are 5
subject data files
for the Tutorial
experiment.  The
data files are
displayed in the
File List window on
the right side of the
display.

2) In the File List (on
the right side of the
display), you should
see a list of files as
shown to the right.
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Task 3:  Merge data files

This step will guide you in selecting individual data files to be merged into a target file.

1) Click the Select
Unmerged tool to
select all E-Prime
data files (*.edat)
that have not yet
been merged into
another file.

An individual file
may be selected
by clicking on the
file name.

2) Click the Merge
tool button on the
toolbar.

3) Click Next for
Standard Merge in
the Select the
Merge Operation
dialog.

4) In the Set Target
File dialog, navi-
gate to the C:/My
Experiments/Tutori-
als/Data folder and
type “Merged
Tutorial Data” in
the File name field.
Click OK.

The results of
the merge
operation will be
sent to the target
file (Merged
Tutorial
Data.emrg in the
Data folder).

Continued next page...
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5) Since the target file
does not already
exist, a dialog is
displayed asking if
you would like to
create it.  Click Yes.

6) A dialog is dis-
played summarizing
the results of the
merge operation.
Click OK to dismiss
the Merge Results
dialog.

Task 3 continued...
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Task 4:  Examine merge results

This step guides you through an examination of the results from the previous merge opera-
tion.

1) Notice the icons to
the left of the data
files (*.edat) in the
File List window.
These indicate that
the files have been
merged.

The icon for a
merged data file
consists of a green
checkmark on the
E-Prime icon.

2) The Last Merged
column for each of
the data files lists
the date of the
merge operation just
performed.

3) Merged Tutorial
Data.emrg is now
listed in the File
Name column and
receives the desig-
nation of “TARGET”
in the Status col-
umn.

4) The icon to the left
of Merged Tutorial
Data.emrg is the
icon for a target file.

x
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Continued next page...

Page 55



     E-Prime:  Getting Started Guide
    Application:  E-Merge

y

z

5) The Last Modified
column for the
Target File (Merged
Tutorial Data.emrg)
lists the date of the
merge operation.

Note that Merged
Tutorial Data is
the only file that
has been modified.

6) The Merge Log
window, displayed
at the bottom of the
application, displays
the details of the
merge operation
(including:  the
name of each
merged file, the
result of the opera-
tion, the number of
selected files
merged, and the
number of files not
merged).

7) Exit the application.

Task 4 continued...

Your merged data is now ready for input into E-
DataAid!
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Preparing Data for
Analysis

Task 1:  Open E-DataAid

The E-DataAid application may be used to examine your data and prepare it for export to a
tab-delimited text file so that it may be read into another application (such as Excel).  This
step guides you through opening the E-DataAid application.

1) From the Start menu,
select Programs, E-
Prime, and E-DataAid.

The E-DataAid
application does not
open to a specific data
file or to a blank file.  A
file must be opened
within the application.
The only active tool
button is the Open
button.

u
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Task 2:  Open a data file

This step guides you through locating and opening the data file to be used in this tutorial.

Note:  You MUST run the Merging Data Files tutorial in this manual in order to create the
Merged Tutorial Data.emrg file that is used here in Task 2.

1) Select the Open
command from the File
menu.

The Admin Open
command allows the
user to set security
options.

2) In the Open dialog,
navigate to the Data
folder in C:\My
Experiments\Tutorials\Data
directory.

3) Select the Merged
Tutorial Data.emrg
file.

The Merged Tutorial
Data.emrg file contains
data from the 5
subjects who
participated in the
Tutorial experiment.

4) Click Open.
The spreadsheet
contained within the
selected file will be
displayed.

x
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Task 3:  Filter the data

This step guides you through filtering the data to include only those trials during which the
subject responded correctly.

1) Click the Filter tool button
to display the Filter dialog.

The Filter dialog may also
be displayed using the
Tools menu.

2) Select Target.ACC in the
“Column name” list and
click the Checklist button.

The Target.ACC variable
contains the accuracy of
the subject’s response for
each trial (0=incorrect,
1=correct).

3) On the Checklist page of
the Filter dialog, click the
checkbox next to “1” to filter
for (i.e., include) only cor-
rect responses.

4) Click OK to apply the filter.
The display will be
refreshed to show only
correct answers, and
Target.ACC=1 will be
listed in the “Current
filters” field on the Filter
dialog.
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Continued next page...
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Task 3 continued...

5) Click Close in the
Filter dialog to dis-
miss it.

6) Notice that the
Filters Bar at the
bottom of the display
lists Target.ACC=1
as an active filter.

7) Notice that the
Target.ACC column
header will be dis-
played in white to
indicate that a filter is
now in place.
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Task 4:  Edit the cells

This step illustrates how to edit the values within the spreadsheet, and how E-DataAid
displays altered data.  For this example, we incorrectly assigned one of our subject num-
bers, so we need to change the subject number for that subject.

1) Click in the first cell
under the Subject
column to select it.

2) Change the Subject
number in this cell from
“1” to “11” by typing
directly in the cell.

3) Press <Enter> or click
in another cell to accept
the edit to the Subject
number.

E-DataAid displays all
alterations to data in
red.  All cells in the
Subject column
associated with this
session of data have
been modified to
display “11” in red.
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Task 5:  Analyze the data

This step illustrates how to use the Analyze command to create a table of means for reac-
tion time by condition.

1) From the Tools Menu,
select the Analyze com-
mand, or click the Analyze
tool button.

The Analyze dialog will be
displayed.

2) In the “Name” field, type
“Mean RT by Condition”
as the title for the analysis.

3) In the Variables list, click
NameGender, and drag it
to the Columns list to
designate it as a column.

4) Designate PrimeType and
PrimeGender as Columns.

This will create one cell per
condition according to the
levels of the independent
variables (2 x 2 x 2).

5) Click Subject in the Vari-
ables list and drag it to the
Rows list.

6) Click Target.RT in the
Variables list and drag it to
the Data list.

Note that you may double
click on a variable in the
Rows, Columns, or Data list
to change the stat.

Continued next page...
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Task 5 continued...

7) Click Run.
This will display a table
dialog showing the
mean reaction time per
condition for each of
the subjects.
Because we filtered for
only correct responses,
and because we have
only a few subjects,
some of the cells are
empty.
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Task 6:  Export table of means to StatView

In this step, you will export the table of means to a text file for import into StatView.

1) Under “Display Mode,”
which is located to the
right of the Table, click
the radio button next to
StatView and SPSS.

The table will be
altered to show the
StatView orientation.

2) Click the Export
button, which is located
to the right of the Table.

The Export dialog is
displayed in order to
set the options for
export.

3) In the Export dialog,
select StatView and
SPSS (default) in the
drop-down box under
“Export to,” and this will
automatically set the
default options for
export to StatView.

4) Click the OK button at
the bottom of the Ex-
port dialog.

Continued next page...
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Task 6 continued...

5) In the Export As dialog,
navigate to the C:\My
Experiments\Tutorials\Data
folder and type “Table
of Means” in the “File
name” field.

6) Click Save.
The table of means will
be saved as a text file
in the Data folder.

7) Close the Table and
Analyze dialogs.  When
you close the Analyze
dialog, you will be
prompted to save the
analysis.  Click No to
continue.

The settings for the
analysis could be
saved to be reloaded
at a later time.
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Task 7:  Export data to text

In this step, you will export the displayed spreadsheet data to a tab-delimited text file, which
may then be imported into Excel.

1) Select the Export
option from the File
menu.

The Export command
exports the currently
displayed spreadsheet
data to a text file,
including any filters
currently applied (i.e.,
Target.ACC=1).

2) In the Export dialog,
set the “Export to” field
to Excel.

The appropriate
settings are already
defined, so all of the
remaining fields remain
inactive.

3) Click OK.

4) In the Export As dialog,
navigate to the C:\My
Experiments\Tutorials\Data
folder and type “Ex-
ported Tutorial Data”
in the “File name” field.

5) Click Save.
The displayed data will
be exported to a tab-
delimited fext file
(Exported Tutorial
Data.txt), which can
easily be imported into
Excel.
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Task 8:  Create an Excel plot

This step illustrates how to use the Analyze command and a table of means (reaction time
by condition) to create an Excel plot.

1) Continue using the
Merged Tutorial
Data.emrg file to cre-
ate the Excel plot.

2) From the Tools menu,
select the Analyze
command, or click the
Analyze tool button.

The Analyze dialog will
be displayed.

3) In the Variables list,
click PrimeGender,
and drag it to the
Columns list to desig-
nate it as a column.

4) Click NameGender in
the Variables list, and
drag it to the Rows list.

5) Click Target.RT in the
Variables list, and drag
it to the Data list.

Note that you may
double click on a
variable to change the
stat.

6) Click Run.
This will display a
Table dialog showing
the mean reaction time
for PrimeGender by
NameGender.

Continued next page...
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Task 8 continued...

7) Click the radio button
next to Plot under
Display Mode in the
Table dialog.

This will enable the
Excel Plot button in the
Table dialog.

8) Click the Excel Plot
button.

E-DataAid will launch
Excel and plot the data.

9) Inspect the Excel plot
that is created by E-
DataAid.  Then exit
Excel without saving.

10) Close the Table and
   Analyze dialogs.

11) Exit E-DataAid with-
out saving (select Exit
from the File menu and
when asked, “Save
Changes?” click No).

{
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Task 9:  Import text file into Excel

In this step, you will import the text file containing the merged data into Excel.

1) Open Excel.

2) From the File menu in
Excel, select Open.

3) In the Open dialog,
navigate to the folder
containing you Ex-
ported Tutorial Data.txt
file (C:\My  Experi-
ments\Tutorials\Data).

Be sure the Files of
Type field in the Open
dialog is set to “Text
Files.”

4) Select Exported
Tutorial Data.txt.

5) Click Open.

6) In the Text Import
Wizard, click Finish.

The Exported Tutorial
Data.txt file will be
opened in an Excel
spreadsheet.  Header
information is included:
a list of the path and
filename for the
imported data file, a
notice that the file
contains edited data,
and information about
the filter that was
placed on the data
when it was exported
(Target.ACC=1).

7) Exit Excel (select Exit
from the File menu).
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Task 10:  Import table of means into StatView

Complete this step only if you have purchased a copy of StatView.  In this step, you will
import the table of means into StatView.

1) Open StatView.

2) From the File menu in
StatView, select Open.

3) In the Open dialog,
navigate to the folder
containing your Table
of Means.txt file (C:\My
Experiments\Tutorials\Data).

4) Select Table of
Means.txt.

5) Click Open.

6) In the StatView Import
dialog, click Import to
accept the default
settings.

The Table of Means.txt
file is a tab-delimited
text file with numeric
and string data.  The
Import command will
open a dialog
displaying the Table of
Means.txt data in
StatView format.

7) Close the Table of
Means.txt dialog in
StatView without sav-
ing.

8) Close StatView.
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Advanced Tutorials
The advanced tutorial exercises will guide you through modification of the experiment that
you created in the E-Studio tutorial.  You must have successfully completed the E-Studio
tutorial before attempting to work through the following exercises.

In the following set of tutorials, you will learn how to:

•  Modify an existing experiment to use images rather than text stimuli.

•  Modify an existing experiment to present sound and text simultaneously.

•  Modify an existing experiment to accept input from the PST Serial Response Box.

•  Add user-written script to an existing experiment.
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Tutorial 1:  Modify Tutorial.es to
present pictures

This tutorial assumes that you have successfully completed the E-Studio tutorial in this
manual.  Do not attempt to work through the following tasks unless this assumption is
correct.

Task 1.1:  Open Tutorial.es and save as
PictureTutorial.es

This task will save a copy of the Tutorial.es experiment under a new name in order to make
some modifications.

1) Within the E-Studio
application, open
Tutorial.es.

2) In the File menu,
select the Save As
command.

3) In the Save As dialog,
change the “File name”
field to “Picture Tuto-
rial” and then click
Save.

PictureTutorial will
automatically be opened
in E-Studio.
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Task 1.2:  Create an ImageDisplay object

This task will create an ImageDisplay object, which will be used to present images rather
than text.

1) Click the ImageDisplay
object in the Toolbox
and drag it to the
Workspace.

A new ImageDisplay
object will be created
in the Workspace and
will appear in the
Structure window (in
the Unreferenced E-
Objects folder).

2) Rename the
ImageDisplay object as
PictureTarget.

The PictureTarget
object is going to
replace the Target
object from the Tutorial
experiment.

3) Click the Properties
button to display the
Property Pages.  On
the General tab, enter
[Target] in the
“Filename” field to
indicate that the image
to be displayed will
vary according to the
Target attribute.

Instead of text, as in
the Tutorial
experiment, the Target
attribute will hold the
filenames of the
images to display.
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Task 1.2 continued...

4) On the Duration/Input
tab, do the following:

    •  Set the Duration to
    10000 milliseconds

    •  Add the keyboard as
    the input Device

    •  Set the Allowable
    response field to the
    “1” and “2” keys
    (by entering “12”)

    •  Set the Correct field
    to [CorrectAnswer]

    •  Set the trial to Termi-
    nate upon response

    •  Set Data Logging to
    “Standard”

    When you are finished
on this tab, close the
Property Pages by
clicking the OK button.

These are the settings
used by the Target
object in Tutorial.  We
are simply changing
the type of stimulus
presentation.
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Task 1.3:  Add PictureTarget to the trial procedure

This task will guide you through the replacement of the text stimulus display with the pic-
ture display.

1) Open the TrialProc in
the Workspace.

2) From the Unreferenced
E-Objects folder in the
Structure window, drag
the PictureTarget object
to the right of the Tar-
get object.

3) Click the Target object
to select it.

4) Delete the Target
object from the
TrialProc.

To do this, select the
Target object and
press the Delete key,
or right click on the
object after
selecting it and choose
the Delete command
from the context menu
that appears.
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Task 1.4:  Modify the List object

This task will guide you through the modification of the List object to list the names of the
images to display rather than text.

1) Open the TrialList
object  in the
Workspace.

2) In the Target attribute
column, modify the
values to name your
image files.

Female.bmp and
male.bmp are
included in the \My
Experiments\Tutorials
folder as part of the E-
Prime installation.
These files must be
copied to the current
directory.
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Task 1.5:  Edit the Feedback object

This task will guide you through the editing of the Feedback object in order to modify the
input object.

1) Click on the Feedback
object in the Structure
window to display its
properties in the Prop-
erties window.

IMPORTANT!  Before
you proceed to the
next item, verify that
FeedbackDisplay is
actually displayed
within the drop-down
window at the top of
the Properties window.
If it is not, be sure to
select the Feedback
object from the
drop-down list before
proceeding.

2) In the
InputObjectName field,
change Target to
PictureTarget.
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Task 1.6:  Edit the Instructions

This task will guide you through editing the instructions for the experiment.

1) Open the Instructions
object in the
Workspace.

2) Edit the Instructions to
be relevant to the
modified program.

Specifically, you should
remove the text “target
word” and replace it
with “picture” or
“image.”  Also change
the word “name” to
“image.”

3) Verify that your experi-
ment structure re-
sembles that to the
right.  Save and Run
the PictureTutorial
experiment.

The experiment should
be identical to the
previous E-Studio
tutorial experiment with
two exceptions.  First,
the instructions should
be modified to reflect
that the target is a
picture rather than
text.  Second, the
target stimuli should
actually appear as
child-like figure
drawings of either a
boy or a girl.
Note that the images
necessary are supplied
within the \My
Experiments\Tutorials
folder.
IMPORTANT!  The
images must be
copied and saved in
the same folder as
PictureTutorial.es.

Note:  If you experience Run-time errors, refer to the Trouble-
shooting section in this manual.
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Tutorial 2:  Modify Tutorial.es to
present sound
This tutorial assumes that you have a DirectX Audio card installed on your PC.  In addition,
this tutorial assumes that you have successfully completed the E-Studio tutorial.  Proceed
with this tutorial only if these assumptions are correct.

Task 2.1:  Open Tutorial.es and save as
SoundTutorial.es

1) Open Tutorial.es in E-
Studio.

2) In the File menu,
select the Save As
command and save
Tutorial as
SoundTutorial.es.

SoundTutorial will
automatically be
opened in E-Studio.
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Task 2.2:  Create a Slide object

This task will create a Slide object in the trial procedure which will be used to present
simultaneous text and sound.

1) Click on the Slide
object in the Toolbox
and drag it to the
Workspace

A new Slide object will
be created in the
Workspace and will
appear in the
Structure window in
the Unreferenced
E-Objects folder.

2) Select the Slide object
from the dropdown box
and Rename it to
SlideTarget.

The SlideTarget is
going to replace the
Target object from the
Tutorial experiment.

3) Click the Default tab at
the bottom of
SlideTarget in the
Workspace.

The default SlideState
becomes active.
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Task 2.3: Add text to the Slide object
This task will add a text block to the Slide object so that it can present text stimuli.

1.)  Click the text tool on
the Slide tool bar, then
click anywhere within the
active Slide window.

A standard text sub-
object will appear in
the Slide window.

2.) Use the drop-down
menu on the Slide toolbar
to make sure the text
block is the active object
on the Slide. Then click
the Properties button on
the Slide toolbar.

The drop-down
menu allows you to
individually select
the entire Slide,
slide states, or sub-
objects on the Slide.
When setting prop-
erties on the Slide,
you set them only
for the active object.

3.) On the Frame tab for
the text block, set the X-
and Y- Position proper-
ties to Center.

This will center the
text block in the middle
of the Slide.

4.) On the General tab,
enter [Target] in the Text
field to indicate that the
text to be displayed will
vary according to the
Target attribute, which
was created earlier in the
TrialList.
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Task 2.4: Add sound to the Slide object
This task will create a sound sub-object on the Slide, so that sound stimuli can be pre-
sented simultaneously with text.

1.) Click the sound tool
on the Slide tool bar, then
click anywhere within the
active Slide window.

A sound sub-
object will appear in
the Slide window.
The sound sub-
object will not be
visible at run-time,
and can be placed
anywhere on the
Slide itself.

2.) Use the drop-down
menu on the Slide toolbar
to make sure the sound
sub-object is the active
object on the Slide. Then
click the Properties
button on the Slide
toolbar.

3.) On the General tab,
set the Filename field of
the sound sub-object to
refer to [SoundFile].

The SoundFile
attribute will be added
to the TrialList in the
next step.  The file-
name for the sound
sub-object will be
resolved by this attri-
bute at run-time.

4.) Click OK to dismiss
the Properties pages.
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Task 2.5: Set Duration/Input properites for the
SlideTarget

1.) Use the drop-down
menu on the Slide
toolbar to select the
entire Slide object.
Then click the Proper-
ties button on the Slide
toolbar.

2.) On the Duration/Input
tab, do the following:

    •  Set the Duration to
    10000 milliseconds

    •  Add the keyboard as
    the input Device

    •  Set the Allowable
    response field to the
    “1” and “2” keys
    (by entering “12”)

    •  Set the Correct field
    to [CorrectAnswer]

    •  Set the trial to Termi-
    nate upon response

    •  Set Data Logging to
    “Standard”

    When you are finished
on this tab, close the
Property Pages by
clicking the OK button.

These are the settings
used by the Target
object in Tutorial.  We
are simply changing
the type of stimulus
presentation.
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Task 2.6:  Add SlideTarget to the trial procedure

This task will guide you through the replacement of the text stimulus display with the pic-
ture display.

1) Open the TrialProc in
the Workspace.

2) From the Unreferenced
E-Objects folder in the
Structure window, drag
the SlideTarget object
to the right of the Tar-
get object.

3) Click the Target object
to select it.

4) Delete the Target
object from the
TrialProc.

To do this, select the
Target object and
press the Delete key,
or right click on the
object after
selecting it and choose
the Delete command
from the context menu
that appears.
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Task 2.7:  Modify the List object

This task will add the SoundFile attribute to list the audio files to present.

1) Open the TrialList
object in the
Workspace.

2) Use the Add Attribute
tool button to add an
attribute called
SoundFile.

3) Enter the names of the
sound files to present
as values for the
SoundFile attribute.

Two audio files
(Bob.wav and
Linda.wav) are
included in the \My
Experiments\Tutorials
folder as part of the E-
Prime installation.
Copy these files to
your current directory.
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Task 2.8:  Edit the Experiment object

This task will guide you through editing the Experiment object to designate the format of
the audio files to present.

1) Open the Experiment
object in the
Workspace by double
clicking the Experiment
object icon in the Struc-
ture window.

2) Click on the Devices
tab of the Experiment
Object dialog.  Click
the box next to the
Sound device to add
sound to the experi-
ment.  Then click
Sound to highlight it
and click the Edit
button.

3) In the Edit
SoundDeviceObject
Properties dialog, set
the properties of the
sound device to format
the buffer to present
*.wav files saved as 2
Channels (stereo),
22050 Hz, and 8 Bits
Per Sample.  Click OK.

4) Click OK in the Experi-
ment Object dialog to
close it.
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Task 2.9:  Edit the Feedback object

This task will guide you through the editing of the Feedback object in order to modify the
input object.

1) Click on the Feedback
object in the Structure
window to display its
properties in the Prop-
erties window.

IMPORTANT!  Before
you proceed to the
next item, verify that
FeedbackDisplay is
actually displayed
within the drop-down
window at the top of
the Properties window.
If it is not, be sure to
select the Feedback
object from the
drop-down list before
proceeding.

2) In the
InputObjectName field,
change Target to
SlideTarget.
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Task 2.10:  Edit the Instructions object

This task will guide you through editing the instructions for the experiment.

1) Open the Instructions
object in the
Workspace.

2) Edit the Instructions so
that they are appropri-
ate for the modified
experiment.

3) Verify that your experi-
ment structure re-
sembles that to the
right.  Save and Run
the experiment.

The experiment should
be identical to the first
E-Studio tutorial
experiment with two
exceptions.  First, the
instructions should be
modified to reflect that
 a name will be spoken
through the speakers
at the same time that
the target word
appears.  Second,
during the experiment,
the target word should
be accompanied by a
female voice stating
the name Bob or
Linda.

The WAV files are
supplied within the
C:\My Experiments\
Tutorials folder, and
should be saved
within the same
folder as your
SoundTutorial.es file. Note:  If you experience Run-time errors, refer to the Trouble-

shooting section in this manual.
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Tutorial 3:  Modify Tutorial.es to
accept Serial Response Box input
This tutorial assumes that you have a PST Serial Response Box (model 200-200A) cor-
rectly installed on your PC.  Additionally, it assumes that you have successfully completed
the E-Studio tutorial.  Proceed with this tutorial only if BOTH of these assumptions are
correct.

Task 3.1:  Open Tutorial.es and save as
SRBoxTutorial.es

This task will save the Tutorial.es experiment under a new name in order to make modifica-
tions.

1) Open Tutorial.es in E-
Studio.

2) In the File menu,
select the Save As
command and save
Tutorial as
SRBoxTutorial.es.

SRBoxTutorial will
automatically be
opened in E-Studio.
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Task 3.2:  Add SRBox as input device

This task will add the Serial Response Box/Button Box as an input device.

1) Double click on the
Experiment object to
open a Properties
dialog.

2) Click on the Devices
tab of the Properties
dialog.  Click the Add
button to display the
Add Device dialog.

3) In the Add Device
dialog, select SRBOX
and click OK to add
the SRBox device to
the Experiment object.
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Task 3.3:  Edit the SRBox input device

This task will guide you through editing the Serial Response Box/Button Box input device
to set the parameters.

1) In the Experiment
object Properties dia-
log, select the SRBOX
device.

2) Click the Edit button to
display the SRBOX Edit
dialog.

3) In the SRBOX Edit
dialog, modify the
settings as needed and
click OK.

Accept the default
settings for the Baud
Rate and CPS fields.
Modify the Port
address to match the
COM port to which the
SRBox is connected.
You can download a
program to test the
settings from PST’s
website.

4) Click OK in the Experi-
ment object Properties
dialog to close it.
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Task 3.4:  Enable Response Box input

This task will set the Serial Response Box as the input device for the Target object.

1) Open the Property
Pages for the Target
object, and  click on
the Duration/Input tab.

SRBox input will be
enabled for the Target
object only.  Other
objects will continue to
accept input from the
keyboard.

2) Add the SRBox to the
Input Devices list and
uncheck the Keyboard.

The Keyboard will
remain in the Input
Devices list, and its
settings will be
retained.  This is useful
for switching between
input devices.

3) Click on the SRBox to
select it, and then set
the Input Options as in
the picture to the right.

4) Click OK when you
are finished.
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Task 3.5:  Edit the Instructions

This task will guide you through editing the instructions for the experiment.

1) Open the Instructions
object in the
Workspace.

2) Edit the Instructions to
reflect the use of the
PST Serial Response
Box.

3) Save and Run the
experiment.

The experiment should
be identical to
Tutorial.es with two
exceptions.  It will now
accept the 1 and 2
keys on the SRBox as
allowable input in
response to the
stimulus presented
by the Target object,
and the Instructions
will be changed.

Note:  If you experience Run-time errors, refer to the Trouble-
shooting section in this manual.
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n Select E-Basic Help from the Help menu in E-Studio.

n Click on Help Topics.

n To view information on a particular topic, double click on any item on the Con-
tents tab of the help system (as below), or enter a specific term on the Index
tab.

Tutorial 4:  Modify Tutorial.es to
use script
This tutorial assumes that you have successfully completed the E-Studio tutorial in this
manual.  Do not attempt to work through the following tasks unless this assumption is
correct.

This tutorial will guide you through the process of adding your own script to an experiment.
The added script will determine the location of the stimulus on a clock face.  You will be
asked to enter a number of lines of code into an InLine object in E-Studio.  This is NOT a
tutorial on how to write code.  If you would like help with writing the actual code for an
experiment, see the online E-Basic help or  refer to Chapter 4-Using  E-Basic in the User’s
Guide.  Alternatively, you can follow the steps below to access E-Basic help directly from
E-Studio.
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Task 4.1:  Open Tutorial.es and save as ScriptTutorial.es

This task will save a copy of the Tutorial.es experiment under a different name in order to
make some modifications.

1) Open Tutorial.es in E-
Studio.

2) In the File menu,
select the Save As
command and save
Tutorial as
ScriptTutorial.es.

ScriptTutorial will
automatically be
opened in E-Studio.
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Task 4.2:  Create an InLine object

This task will create an InLine object for the purpose of entering script to determine the
stimulus location.

1) Click the InLine object
in the Toolbox and drag
it to the Workspace.

A new InLine object will
be created in the
Workspace and will
appear in the Structure
window (in the
Unreferenced E-
Objects folder).

2) Rename the InLine1
object as
ClockFacePosition.

The purpose of the
InLine object is to
randomly determine
the location of the
stimulus in a circular
area (i.e., in the
positions on a clock
face).

3) Enter the script (exactly
as shown to the right) in
the ClockFacePosition
object.

The Random command
 randomly selects a
value from 1-12,
representing a location
on a clock face.  The X
and Y coordinate values
are calculated for this
location and are
assigned to the X and Y
properties for the
Target object.  This sets
the location of the
stimulus display for
each trial.
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Task 4.3:  Add ClockFacePosition to the trial procedure

1) Open the TrialProc in
the Workspace.

2) From the Unreferenced
E-Objects folder, drag
ClockFacePosition to
place it as the first
event in the TrialProc.

3) Save and run.
The program will now
present the Target
stimuli at random
locations around the
defined circular area.
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Task 4.4:  Add script to log the random location, and
send information to the Output window

This task will add script to the ClockFacePosition InLine object to log the location of the
stimulus and send information to the Output window.

1) Click in the
ClockFacePosition
object.  Add two lines
of script to
ClockFacePosition to
match the image to the
right.

The c.SetAttrib
command is used to
set the value of x (i.e.,
the random location on
the clock face) as an
attribute to be logged
in the data file.
Otherwise, x is simply
a temporary variable
discarded at the end of
the run.

The Debug.Print
command is used to
send a string to the
Debug tab in the
Output window.  The
string is composed of
the location of the
stimulus display  on
each trial, and the
onset time of the
object presenting the
stimulus.  This output
may be reviewed after
the run terminates in
order to verify the
validity of the values.

2) Save and run.
You will not notice any
difference during the
run, but the next few
tasks will examine the
results of the additional
script.
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Task 4.5:  Examine the logging of the Location attribute
in the data file

1) After the run termi-
nates, select the E-
DataAid command
from the Tools menu.

This opens the E-
DataAid application.

2) In E-DataAid, select
the Open command
from the File menu.

3) In the Open dialog,
select the
ScriptTutorial-1-1 data
file just collected from
the running of
ScriptTutorial.es, and
click Open.

Assuming that the
default subject and
session number were
selected, the data
would have been
collected in a file
named ScriptTutorial-
1-1.edat.

4) Scroll to the right in
the spreadsheet to find
the Location attribute
within the list of vari-
ables at the trial level.

This column lists the
position in which each
stimulus appeared.
According to the script,
the stimulus can
appear in 12 positions
within a circular area
(i.e., like a clock face).

5) Close E-DataAid.

w

u

x

Page 99



     E-Prime:  Getting Started Guide
     Advanced Tutorials

Task 4.6:  View the results of the script in the Output
window

1) In E-Studio, hold down
the Alt key and press
“3” to display the Out-
put window.

By default, the Output
window appears at the
bottom of the
application window.

2) View the output on the
Debug tab in the Out-
put window.

The Debug.Print
command was used to
print the location of the
stimulus display, and
the onset time of the
object displaying the
stimulus to the Output
window during each
trial.

v

3) Close E-Prime.
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